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RAC Preparations 
By Tony Petras, Vice President, EDI Services 

L 
ooming ominously on the horizon, “Section 302 of 

the Tax Relief and Health Care Act of 2006 makes 

the RAC (Recovery Audit Contractor) Program 

permanent and requires the Secretary [of Health and 

Human Services] to expand the program to all 50 states by no 

later than 2010”. CMS plans to have four RACs in place by 2010 

and each RAC will be responsible for identifying overpayment 

and underpayments in approximately one quarter of the 

country.  

This announcement has brought a mixture of reactions from 

our clients ranging from panic to indifference which, for the 

most part, correlates to the level of confidence in the staff, 

policies, and practices of each facility. 

The Quadax perspective is that Xpeditor and its Tracking 

provides highly supportable levels of documentation to explain 

how individual claims are billed—from how the claim was 

imported initially to who 

touched it and what was 

changed before it was 

released. Following that, 

the portion of the 837 

sent to the payer is made 

available to each client, 

allowing them to verify 

that our conversion and 

mapping processes 

maintain the integrity of 

the data supplied. 

However, we strongly 

encourage a review of 

two of Xpeditor’s 

extensively utilized 

capabilities: Custom 

Converts and Xpress-

Billers. This review 

should pay particular 

attention to automatic 

changes to procedure 

and diagnosis codes with 

a critical eye to the 

addition of modifiers to 

resolve edit conflicts. 

The Quadax position is that Custom Converts are created at the 

written request of a client with the philosophy being that the 

rationale for such a modification of claim data is controlled by 

the customer. Likewise, an XpressBiller rule that changes data 

is coded by the end user and includes detailed logging as to the 

individual responsible for creating it. 

In both situations, it is incumbent on you to maintain docu-

mentation in the patient’s record to support the various actions. 

As an example, among our clients the addition of a 59 modifier 

to satisfy errors raised on claims is a common practice. In 

November of 2006, CMS produced a white paper (http://

www.oig.hhs.gov/oei/reports/oei-03-02-00771.pdf) on the use 

of the 59 modifier as a means to bypass Medicare’s Correct 

Coding Initiative edits as well as a document (http://

www.cms.hhs.gov/NationalCorrectCodInitEd/Downloads/

modifier59.pdf) that further defines the code (also noted in the 

June 2007 issue of Connections). Within it, CMS warns, 

“Modifier -59 is an important NCCI-associated modifier that is 

often used incorrectly”. 

Use the opportunity of the recent announcement—the final 

Medicare Administrative Contractors (MACs) and the auto-

matic stay on audits due to the protest—to review your facility’s 

usage of Custom Converts and XpressBillers to satisfy edit 

concerns. The EDI Services support team is standing by to help 

you in whatever capacity we can. 

 Adam Tolowitzki (right) accepts the EDI Employee of the 

Year award from EDI Services Vice President, Tony Petras 

(left), and EDI Services CEO, Tom Kish (center).  Read more 

about the EDI department on page 4. 
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Final MAC Jurisdictions 
By Katherine Doerfler, Technical Writer 

C 
MS has completed the Medicare Administrative Contrac-

tors (MACs) assignments by announcing the final five 

MACs responsible for processing Medicare claims in five 

remaining jurisdictions. Each new MAC is expected to be 

fully responsible for claims processing in its jurisdiction by March 

of 2010, and, in the meantime, work toward a smooth transition by 

educating healthcare providers, state medical associations, and 

beneficiaries of the implementation process and what to expect. 

CMS instituted the MACs in order to consolidate the processing of 

claims by jurisdiction to encourage efficient and correct claim 

submission and payment. Nineteen MACs were awarded contracts 

spanning 19 jurisdictions. These include 15 A/B MACs, which are 

responsible for institutional (UB-04) and professional (CMS1500) 

claims, and four specialty MACs, which are responsible for durable 

medical equipment suppliers. After the respective “go-live” date, 

each MAC will be responsible for the receipt, processing, and 

payment of Medicare fee-for-service claims within the states 

assigned to its jurisdiction. Previously, Medicare claims were 

processed by many fiscal intermediaries and carriers, which often 

resulted in incorrect submission and slower payment. For more 

details from CMS regarding the MAC transition and implementa-

tion, see http://www.cms.hhs.gov/MedicareContractingReform/.  

Now that the final five A/B MACs have been announced, please 

note the following to encourage a smooth transition: 

Some providers may need to complete new Electronic Data 

Interchange Enrollment Forms or ERA Enrollment forms. 

Quadax Service Representatives contact providers if these 

forms need to be completed. 

On the UB side, specialty services (home health and 

hospice) may go to a regional MAC, which is different than 

the contractor for part A and B claims. When this occurs, a 

new claim type is needed for UB billing. Quadax identifies 

these situations and makes the necessary changes so the 

claims go to the correct MAC. 

As the “go-live” date nears, the MAC may impose “dark 

days” in order to switch their system to the new provider. 

During this time, the Medicare claims processing system 

will not be available for normal business operations and 

claims will not be processed.  

A “payment floor release” may be temporarily instituted, 

typically two weeks, to ensure all provider payments are 

cleared from the previous system by the end of the transi-

tion period. During this time, providers will see increased 

payments; however, providers will see smaller checks as the 

system starts up for the new workloads because the 

payment floor will be beginning in the new processing 

environment. 

As the transition process continues, Quadax will keep you 

informed as issues arise. If you have any questions about how 

the transition will affect you, contact your Quadax Service 

Representative. 

Jurisdiction # States Included in Jurisdiction Contract Awarded to Go-Live Dates 

1 American Samoa, California, Guam, Hawaii, 
Nevada, and Northern Marianas 

Palmetto GBA August 2008 

2 Alaska, Idaho, Oregon, and Washington National Heritage Insurance 
Corp. 

December 2008 

3 Arizona, Montana, North Dakota, South Da-
kota, Utah, and Wyoming 

Noridian Administrative Services March 2007 

4 Colorado, New Mexico, Oklahoma, and Texas TrailBlazer Health Enterprises March to June 2008 

5 Iowa, Kansas, Missouri, and Nebraska Wisconsin Physicians Health 
Insurance Corp. 

December 2007 to June 
2008 

6 Illinois, Minnesota, and Wisconsin Noridian Administrative Services March 2010 

7 Arkansas, Louisiana, and Mississippi Pinnacle Business Solutions, Inc. February 2009 

8 Indiana and Michigan National Government Services March 2010 

9 Florida, Puerto Rico, and U.S. Virgin Islands First Coast Service Options, Inc. March 2009 

10 Alabama, Georgia, and Tennessee Cahaba GBA March 2010 

11 North Carolina, South Carolina, Virginia, and 
West Virginia 

Palmetto GBA March 2010 

12 Delaware, District of Columbia, Maryland, 
new Jersey, and Pennsylvania 

Highmark Medicare Services July to December 2008 

13 Connecticut and New York National Government Services July to November 2008 

14 Maine, Massachusetts, New Hampshire, 
Rhode Island, and Vermont 

NHIC May 2009 

15 Kentucky and Ohio Highmark Medicare Services March 2010 

Final MAC Jurisdictions (new contracts in red) 

http://www.cms.hhs.gov/MedicareContractingReform/
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Annual Partners’ Dinner 
By Cyndi Palmer, Marketing/Communications Manager 

A 
t the annual Partners’ Dinner held January 14, 2009, 

John Leskiw cited the recent statistic that average 

tenure of service sector employees in the United States 

ranges between two and five years. Given that four 

Quadax Partners were being recognized that evening for passing 

their twentieth anniversaries with the company, and that the 

average tenure among all Partners is 16.7 years, it’s easy to see 

that there’s something different—something special—about 

Quadax Incorporated. 

That something special is embodied in the individuals who 

represent the Quadax Partner program. The program was estab-

lished nine years ago to honor employees performing at an 

exemplary level and meeting certain eligibility criteria, including 

years of service and contributions to the company’s profitability. 

Each year since the program’s inception, an annual dinner 

meeting affords the opportunity to review accomplishments, 

applaud special achievements, reinforce vision, and welcome new 

Partners who will help make that vision reality.  

The applause for our four twenty-year honorees was well-

deserved:  Catherine Sicker, Corporate Compliance Officer; 

Mark Sprowls, Vice President, Systems; Brent Pagel, Opera-

tions Manager, EDI Services; and Nick Halpin,  Technical 

Manager on the Xpeditor Implementation Team. Each has made 

numerous significant contributions to corporate success through 

the last two decades. 

Special recognition was also given to Mark Tibbs, Quadax 

Partner and Corporate Controller, for his monumental efforts in 

2008 related to the purchase of our new building and other 

financial matters. Mark works behind the scenes, but the effect of 

his effort is transparent only because of the diligence and excel-

lence with which he performs every task. John Leskiw, Chief 

Executive Officer, explained that Mark’s “clean, timely, and hair-

free output empowers us to make good business decisions.” 

John called 2008 “a tumultuous year for Quadax” in his remarks 

to the group. The move of our corporate headquarters from 

Fairview Park to Middleburg Heights was just one of the events 

contributing to the hectic feel, others being the adoption of a 

completely new phone system, the move of all our systems to 

datacenter host Expedient, changes in the market and our client 

base, and the retirement of our long-time Human Resources 

Manager. In such a year, everyone’s contributions are important, 

and exceptional demonstrations of integrity, dependability, 

innovation, and loyalty shine all the more brightly.  Those are the 

defining characteristics of members of the Quadax Partner 

program, and they are characteristics readily apparent in this 

year’s two inductees, Alana Papp and Art Juarez. 

Entry into new territories was one of the bright spots that John 

Leskiw highlighted in his remarks to the assembled Partners 

about the year behind us and the year before us. Pressures exist, 

as they do for everyone in today’s business community, but we 

have reasons to be encouraged, with new opportunities before us. 

As we pursue those, while continuing to deliver innovative, 

relational service with integrity and dedication, we will remain 

strong—for the benefit of our valued clients, and our valuable 

employees, whatever their tenure might be.  

RAC Audit Readiness with ECM 
By Phil Conard , Vice President of ECM Services 

W 
ith the Tax Relief and Health Care Act of 2006, 

the Medicare Recovery Audit Contractor (RAC) 

program is projected to be fully commissioned by 

2010. To the provider community, the commis-

sioning of the program is raising many concerns in audit readi-

ness. These concerns have manifested themselves through the 

following: 

Documentation required for RAC audits 

In the unfortunate event that an appointed RAC initiates an audit, 

the provider will be required to respond with the provisioning of 

Medical Records. Depending on the capability of the appointed 

RAC, the provisioned Medical Records can be submitted in either 

a hardcopy or an electronic (i.e. image) manner. In most cases, 

request for Medical Records will not encompass Claims or Remits, 

as the commissioned RACs have access to the said items through 

the CMS National Claims History repository. 

Timelines governing RAC audits 

A provider will have 45 calendar days to respond to a RAC’s 

request for Medical Records. In responding to the RAC’s request, 

the provider can either provision the Medical Records or request 

an extension. In requesting an extension, the provider must 

formally reach out to the appointed RAC within the 45 calendar-

day window. 

Administrative costs associated with RAC audits 

Many variables come into play in assessing the administrative 

costs associated with RAC audits. How prone is the provider’s 

practice/medical discipline to RAC scrutiny? Can provisioned 

Medical Records be efficiently gathered for submission to the 

requesting RAC? Unfortunately, with the said variables, there is 

(Continued on page 8) 
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T 
he annual Quadax EDI State of the Department 

Meeting is a much-anticipated event attended by all 

members of EDI Services, EDI Systems, as well as 

officers of the company and specially invited guests. 

The purpose of the meeting is to outline the previous year’s 

achievements and to illustrate the goals for the new year. EDI 

Services Vice President Tony Petras deliveres the key presentation 

and annual awards, while selected departments within EDI 

Services also provide informative updates on their respective 

areas.  

A review of 2008 would be 

incomplete without mention of 

the move of the Quadax 

corporate headquarters from 

Fairview Park to Middleburg 

Heights. Following a year of 

waiting and watching the 

remodeling and construction 

project, three hundred and fifty 

employees relocated to the new 

location in one nearly seamless 

weekend. The move consolidated 

satellite offices to provide all 

teams with a pleasant and 

collaborative workplace 

environment.  

A number of significant 

accomplishments of 2008 were 

highlighted during the meeting, 

including these statistics:  

Over 45 million transactions were processed. 

Our Service Team performed 2,608 on-site visits to clients.  

Our Transmissions team conducted 96,810 transmissions 

which was a 23% increase from last year. 

Fifteen new payers were added for direct-connect transmis-

sions.  

While the numbers are impressive, we recognize that statistics are 

meaningful only because they represent real value provided to our 

customers. These and other accomplishments for 2008 have a 

direct bearing on our clients’ success. For example: 

A Quality Assurance area was developed within EDI 

Technical Services as a way to provide a greater focus to the 

testing of edits and enhancements.  

Quadax submitted to review and was successfully reaccredi-

ted according to EHNAC standards of excellence. EHNAC is a 

nationally recognized authority for electronic healthcare 

transactions and healthcare information management. 

The establishment of XpressBiller Online improved the 

efficiency of client-configured custom programming and 

enhanced documentation and tracking. 

Templates, created for entering Help Desk events and 

enabled for client use, improved the capture of key informa-

tion, thereby reducing the time from entry to successful 

resolution.  

Another milestone 

accomplishment for 2008 

was the transition from 

Classic Xpeditor to 

Xpeditor Five Series as 

our exclusively sold 

product. As 2008 opened, 

Five Series was installed in 

only three facilities. By 

May, Five Series was 

established as our single 

product and sold in two 

versions, Xp5E for 

enterprise installations 

and Xp5i for hosted 

engagements.    

Xpeditor Five Series is 

Quadax’s premier 

electronic processing 

machine, which offers 

claim management, claim status, remittance transactions, 

reporting, and denial management. Associated with this accom-

plishment was the migration of all Xp Online clients to the 

browser-based Xp5i. Converting most, if not all of the remaining 

Classic Xpeditor Enterprise clients to either Xp5E or Xp5i is one 

of the goals for 2009.  

Other goals and special projects planned for 2009 include 

instituting additional Quality Assurance improvements; the 

completion of the Denial Management application which will 

generate more revenue for our clients by monitoring, analyzing, 

and managing claim denials; the development of a Customer 

Relations Management Dashboard; and creating a Recovery Audit 

Contractor (RAC) solution.  

The message of the afternoon was clear: though uncertainty 

characterizes nearly everything in today’s economic environment, 

Quadax EDI Services has a strong foundation and is well-

positioned to offer our clients stability and success.  

EDI State of the Department 
By Emily Emmerich, Marketing Communications Specialist 

EDI employees honored as “Unsung Heroes” during the 2008 State of 

the Department meeting: (front row from left to right) Margo 

McCarthy, Ann Chesney, Dean Lauria, (back row) Barb Ballas, Candy 

Thompson, and Nelson Laracuente.  
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W 
ith 2009 in full swing, this is a good time to look 
at ways to get more out of Quadax and Xpeditor! 
Specific resolutions may be unique to every 
environment, but these goals make sense for just 
about any of our valuable clients.  

#1:   Get five series serious!  

If you haven’t already jumped in and migrated to our browser 

based version of Xpeditor, climb aboard!  Enterprise users can 

accomplish this by adding a webserver and scheduling the 

migration with Quadax. If adding equipment and maintaining an 

enterprise environment is not desirable, the Quadax hosted Xp5i 

version is a viable alternative. Migrating to either platform is 

straightforward and offers very little learning curve  and no 

interruption in your production environment.  

#2:   Plan to attend the annual user conference. 

Mark your calendars for May 5th and 6th for our Annual User 

Conference. This year we will be in Middleburg Heights, Ohio, 

just minutes from our new corporate headquarters. We will have 

much to talk about as RACs, MACs, 5010, ICD10, denial manage-

ment, and other industry changes and opportunities take shape. 

Sign up early for the discounted rate! 

#3:   Remits, remits, remits. 

Review your inventory of 

electronic remits and determine 

additional opportunities to 

eliminate manual posting of 

these records. Also take advan-

tage of the ability to workflow the payer rejections and automate 

the creation and transmission of secondary claims.  

#4:   Review custom edits/converts, Xpressbiller tasks 

and globals. 

Take time either on your own or in coordination with your 

service representative to review your custom edits/converts, 

Xpressbiller routines, and your Global scripts. If you have been a 

user for over a year, it is very possible that some of these very 

well intentioned tools are now causing unintended results. By 

undertaking a review you may be able to clean up your edits, 

enhance your clean claim rate, and accelerate your AR.  

#5:   Monitor clean claim rate and remove 100% review. 

Do you know what your clean claim rate is? Do you know your 

top ten errors and if there are solutions to eliminating any of 

those errors? Are you stopping all of your claims because that is 

the way you have always done it? Allow us to review your claim 

rate andtop errors, and further automate your claims process so 

it is more efficient and productive!  

Your Quadax/Xpeditor Top Ten List for 2009 
By Len C. Stusek, General Manager, EDI Services 

#6:   Explore the multiple levels of eligibility verification.  

Quadax offers several levels of eligibility verification, both real-

time and batch that may fit into one or more of your information 

workflows. Quadax can integrate the 270 and 271 transaction from 

your HIS system, automate large batch (self pay) interfaces, and 

offer front end applications for real-time inquiries. Are you 

eligible? Yes! 

#7:   Learn about our upcoming denial management 

module. 

In 2009, your best approach to managing denials will not be 

another bolt-on process or product, but rather a solution that 

offers integration with each point on the revenue cycle continuum 

to prevent, monitor, analyze, and manage claim denials. Make it a 

point this year to investigate how Quadax can cost effectively 

weave this application into your revenue cycle tool kit.  

#8:   Get ready for our new and improved portal. 

If you like our existing Portal and all the valuable information 

available, just wait—the new and improved look is coming soon. 

The new interface offers a pleasing experience for you to utilize 

the tools and content we have devel-

oped for you over the years. Plus—new 

training modules and client forums! If 

the Portal is still uncharted territory, 

contact us for an introduction and 

training.  

#9:   Attend a RUG. 

We have been hosting Regional User Group meetings for several 

years now. Watch for announcements as to upcoming events close 

to you. These meetings are great opportunities to catch up with 

what Quadax is doing and what additional functionality is being 

implemented in Xpeditor, and to discuss key industry happenings.  

#10: Tweak your secondary claims process with CASPR. 

(Client Automated Secondary Process Review) 

Many functions and features have been implemented to assist 

your navigation through the creation and submission of secondary 

claims. Learn how you can improve your process and adjust your 

remittance settings to maximize output and reduce much of the 

previous manual intervention.   

As you see, there are many opportunities in the coming year to 

further enlist Quadax to meet your revenue cycle objectives. We 

look forward to assisting you with realizing any of these objectives.

   
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FTC’s Red Flag Rules Apply to Most 
Health Care Providers 
By Catherine Sicker, Corporate Compliance Officer 

T 
he Federal Trade Commission (FTC) issued regulations 

known as the Red Flag Rules, requiring “creditors” to 

establish and enforce written identity theft prevention 

programs, as part of the Fair and Accurate Transaction 

(FACT) Act of 2003 (http://ftc.gov/os/statutes/fcrajump.shtm). 

Originally, the programs were to be in place by November 1, 2008, 

but the deadline was extended until May 2009 because many 

entities, including health care practices, were unaware of its 

existence. 

The Red Flag Rules (http://www.ftc.gov/opa/2007/10/

redflag.shtm) apply to financial institutions and creditors. The 

FTC announced that “Health care providers are creditors if they 

bill consumers after their services are completed. Health care 

providers that accept insurance are considered creditors if the 

consumer ultimately is responsible for the medical fees.” In order 

to be a creditor, a provider has to regularly accept deferred 

payment for services. The AMA has challenged the FTC, stating 

that the rule should not apply to physicians, but the association 

doesn’t know when it might get a response from the FTC. 

The rule requires that a creditor develop a written identity theft 

program that contains reasonable policies and procedures to 

detect, prevent and mitigate identity theft. The regulations set 

forth guidelines for the establishment of an identity theft preven-

tion program and a supplement identifying the relevant warning 

signs, or red flags, of identity theft that should be incorporated 

into the program. 

The World Privacy Forum has issued Suggestions for Health Care 

Providers (http://www.worldprivacyforum.org/pdf/

WPF_RedFlagReport_09242008fs.pdf) which outlines provider 

obligations and best practices, including procedures for address-

ing: 

A complaint or question from a patient based on the 

patient’s receipt of a bill for another individual, a bill for 

a service that the patient denies receiving, a bill from a 

provider that the patient has never seen, or an insurance 

EOB for services never received. 

Records showing medical treatment that is inconsistent 

with a physical exam or with a medical history as 

reported by the patient. 

A dispute of a bill by a patient who claims to be a victim 

of any type of identity theft. 

A patient who has an insurance number but never 

produces an insurance card. 

The basic organizational requirements mandate that the program 

must include reasonable policies and procedures to: 

Identify relevant Red Flags for the accounts that the 

provider offers or maintains and incorporate those Red 

Flags into its program; 

Detect Red Flags that have been incorporated into its 

program; 

Respond appropriately to any Red Flags that are 

detected; 

Update the program periodically to reflect changes in 

risks from identity theft to patients; 

There are also four elements to the administration of the program 

including: 

Obtain approval of the initial written program from 

either its board of directors or an appropriate committee 

of the board of directors; 

Involve the board of directors or a designated employee 

at the level of senior management in the oversight, 

development, implementation, and administration of the 

program; 

Train staff, as necessary, to effectively implement the 

program; 

Exercise appropriate and effective oversight of service 

provider arrangements. 

Formatting HARP Reports in Excel 
By Candace Wintering, TechComm Services Manager 

H 
ARP reports provide essential information for 

managing your A/R. In the last issue of the Quadax 

newsletter, you learned about downloading report 

files and importing them into Excel®. This article 

will cover some of the formatting options that will improve the 

look and readability of report spreadsheet files. Keep in mind 

that we are referring to report files in the comma-separated value 

format and not the actual HARP report.  

Column headings. When you first open a report file in Excel, 

most reports show the report title, number, and other informa-

tion in the first row, followed by column headings in the second 

row. It is easier to work with data when column headings are 

first, so delete the first row. (If you chose to begin importing 

report data at the second row, then the column heading should 

already be on top.) But before deleting the row, consider 

including unique report information (report name, number, date, 

etc.) in the worksheet name, which appears on the worksheet tab, 

or the file name. 

To rename a worksheet, right-click the tab, and then Rename, or 

on the Format menu, point to Sheet and then click Rename.*  

* The specific paths in Excel in this article are for Excel 2003. In 

Excel 2007, many of the options are displayed on the Ribbon so 

will be easier to find. 

(Continued on page 7) 

http://ftc.gov/os/statutes/fcrajump.shtm
http://ftc.gov/os/statutes/fcrajump.shtm
http://www.ftc.gov/opa/2007/10/redflag.shtm
http://www.worldprivacyforum.org/pdf/WPF_RedFlagReport_09242008fs.pdf
http://www.worldprivacyforum.org/pdf/WPF_RedFlagReport_09242008fs.pdf
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Changing the look of all cells in the worksheet. If you want 

to apply changes to all the cells in the worksheet, an easy way to 

select all of them is to click the square in the upper left corner. 

This square is the Select All button. You can then go to Format > 

Cells and change the font size, color, border, alignment, etc. 

 

Fitting columns to data. When you open the spreadsheet, the 

complete column headings or column data may not be in sight 

because the columns are too narrow. A quick way to expand all of 

them at once is to click the Select All button in the upper left 

corner, and then double-click the boundary between any columns. 

This method will also shrink the columns to fit. For example, if 

you change to a smaller font size, click the Select All button again, 

select the font size, and then double-click the column boundary. 

 

Data format. When you imported the file into Excel, you 

selected a broad formatting category for data (number, text, etc.). 

Now you can apply specific formatting to the numbers and dates 

by selecting Format > Cells > Number tab. 

For dollar amounts, select the Currency category, and then 
the number of decimal places and negative number format. If you 
prefer to have the decimal points and dollar signs aligned, select 
the Accounting category instead of Currency. 

For percentages, change the cells to the Percentage category, 

and then specify the number of decimals. 

For dates, change the cells to the Date category, and then choose 

the date format. 

 

 

Freeze Panes. For long or wide reports, you can select rows 

(typically the column headings) or columns that will always be 

displayed while you scroll through the data. To freeze a row or 

column, select the row beneath or the column to the right of the 

one that should be frozen, and then choose Window > Freeze 

Panes. 

Sorting. Excel allows you to sort data in ways that are different 

from the original report sort criteria in HARP. For example, you 

can sort a Charge Summary that includes referrals by the year-to-

date charge amount to easily see the highest performing physi-

cians. To sort, first select a range of cells. In most cases, the range 

should be all the cells because you want to preserve the data 

associations in each row. Select all data by clicking the Select All 

button, and then choose Data > Sort. The Sort By drop-down 

menus list all the column heading for the sort selection. You can 

also choose to sort in ascending order (0 to 9 or A to Z) or 

descending order (9 to 0 or Z to A). 

Filtering. Another powerful feature available in Excel is the 

ability to filter data. Filters allow you to see a subset of data that 

matches specific criteria while retaining all the data on the 

spreadsheet. Filtering just hides rows you do not want displayed. 

You can edit, format, chart, and print the subset without affecting 

other rows on the report. 

To activate filtering, select Data > Auto Filter. An arrow will 

appear next to each column heading. When you click the arrow, a 

list of items in the column is displayed. From the list, select the 

item you want to see. For numbers or dates, the Top 10 option 

opens a box where you can specify the number of items or percent 

of total items to show. You can apply filters to multiple columns. 

Immediately after data is filtered, the results of the filter are 

displayed in the lower-left corner of the status bar (ex. 412 of 2155 

records found). After a time, the number of records changes to 

Filter Mode, indicating that some data is hidden. The filter 

arrow in a filtered column changes to a different color so it is 

apparent which columns have been filtered. 

To show all data on the worksheet again, select Data > Filter > 

Show All, or Show All in the filter arrow list. 

I hope this article provided some useful tips about how to 

customize HARP report spreadsheets to show the data you want. 

The next article in this series will deal with pivot tables. 

(Continued from page 6) 

Rename Worksheet 
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no true way to forecast provider administrative costs. 

So where does this leave the provider community in regards to RAC audit readiness? Apart from the obvious effort 

of avoiding RAC scrutiny by billing in accordance with CMS’s guidelines, providers should prepare themselves to 

react to RAC requests in an efficient and timely manner. One such way to prepare is to maximize any Electronic 

Medical Record (EMR) or Enterprise Content Management (ECM) systems available for use. Both EMR and ECM 

solutions adequately enable providers to efficiently respond to RAC requests for Medical Records, thus reducing 

the administrative burden associated with hardcopy retrieval, copying, and re-filing. The said solutions also 

reduce the element of missing Medical Records, therefore equipping the provider with a chance to defend RAC 

audits.  

For those in the provider community who have not adopted an EMR or ECM solution and have interest, you will 

be happy to learn that Quadax has service offerings in this area. Quadax’s ECM Services’ team specializes in the 

deployment of ECM solutions, offering the solutions in either an affordable SaaS or premise installed business 

model.   

For service inquires, please reach out to Phil Conard, VP of ECM Services at 440-788-2176 or                       

philconard@quadax.com. 

Resources: 

http://www.cms.hhs.gov/RAC 

RAC Audit Readiness with ECM 
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